
PG5: 	Pacchetto software di programmazione  
per controllori Saia® PCD 

Controls Division

Programmazione, pianificazione del progetto e configurazione dei sistemi su base PLC.

Vantaggi del pacchetto software di programmazione PG5
■	 Portabilità dei programmi: i programmi PG5 possono essere eseguiti su tutte le piattaforme 

Saia® PCD.
■	 Organizzazione del programma in file (contenenti diversi blocchi di programma) per 

semplificare l’utilizzo condiviso dei file di programma tra diversi controllori Saia® PCD.
■	 Ambienti di programmazione e di debugging combinati in ciascun editore di programma.
■	 Semplice programmazione delle pagine video dei terminali operatore tramite l’HMI Editor.
■	 Potente set di istruzioni supportato da macro e da direttive assembler.
■	 Accetta i programmi PG3 e PG4 esistenti.

Caratteristiche del pacchetto software PG5
■	 Symbol Manager: gestisce tutti i simboli locali, globali e di rete o gruppi di simboli. 

L’allocazione automatica degli indirizzi permette di evitare il ricorso all’indirizzamento fisso.
■	 Project Manager: configura e gestisce anche complesse installazioni di reti di PCD, ne 

mostra la struttura e ne fornisce la documentazione.
■	 Funzioni online per la messa in servizio ed il rilevamento di errori via Ethernet-TCP/IP, 

Saia® S-Bus, modem, ecc.
■	 Ambienti di programmazione integrati: 

– FUPLA (programmazione con blocchi funzione) 
– S-Edit (IL, programmazione in lista istruzioni) 
– GRAFTEC (programmazione grafica sequenziale)

■	 Editori di rete integrati per Saia® S-Bus, Saia® S-Net, Profibus DP e FMS, LonWorks®. 
■	 Numerose librerie aggiuntive permettono di ampliare la portata delle funzioni PG5. 

Informazioni Tecniche
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Project Manager
Il Project Manager e la relativa finestra «Project 
Tree» (Albero del progetto) forniscono una visione 
d’insieme completa del progetto, anche in caso 
di reti PCD complesse.

Project Tree (Albero del progetto)
È simile a Windows Explorer per aspetto e fun-
zionamento. La finestra «Project Tree» permette 
di accedere direttamente a tutti i PCD utilizzati 
nel progetto, alle loro impostazioni, ai file di pro-
gramma ed a tutti i documenti connessi.
L’organizzazione del programma in file (conte-
nenti uno o più blocchi di programma) semplifica 
l’utilizzo condiviso di file di programma tra più 
PCD. Le parti di programma che sono utilizzate 
in comune si trovano in una cartella di File Co-
muni (Common Files). Le modifiche apportate 
ad un PCD hanno effetto immediato su tutti i 
PCD associati.

Barra degli strumenti
Tutte le operazioni essenziali sono direttamente 
accessibili tramite la tastiera o il mouse, in qual-
siasi momento.

Finestra «View»
Visualizza i dati del programma ed i file di testo, 
con la possibilità di utilizzare filtri, ricerche e 
riferimenti incrociati.
Fornisce una visione d’insieme dei blocchi di 
programma utilizzati, delle risorse assegnate e 
della struttura del programma.

Riferimenti incrociati (Cross-reference)
La lista dei riferimenti incrociati indica dove è 
stato utilizzato un blocco o un elemento nel codice 
del programma.

Finestra «Message»
Visualizza i messaggi del log di generazione, di 
errore e di stato. Gli errori nel codice del pro-
gramma vengono elencati in questa finestra dopo 
la generazione, e possono essere direttamente 
selezionati con il mouse.

Visualizza l’intero progetto 
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Potente gestione dei simboli nei programmi 

Editore dei Simboli (Symbol Editor)
L’Editore dei Simboli è il cuore di PG5. Definisce e documenta tutti i simboli utilizzati dal program-
ma.
■	 I tasti a scelta rapida e l’indirizzamento indicizzato intelligente semplificano l’inserimento dei 

simboli.
■	 Gli editori dei programmi condividono lo stesso Editore dei Simboli. I nuovi simboli inseriti nel 

codice del programma sono aggiunti o letti 
dall’editore dei simboli.

■	 La funzione Import/Export permette di ri-
utilizzare eventuali liste di Ingressi/Uscite 
predefiniti negli schemi elettrici e negli stru-
menti di supervisione di processo.

■	 L’auto-allocazione permette di evitare il ri-
corso all’indirizzamento fisso.

■	 I nomi dei simboli possono contenere fino a 
80 caratteri.

■	 I simboli si possono raggruppare in base alla 
loro funzione. Questo rende più semplice 
l’utilizzo ed il riconoscimento dei simboli 
nell’ambito del programma, e fornisce anche una visione d’insieme più chiara nell’editore dei 
simboli.

Riferimenti incrociati (Cross-Reference)
La funzione «Cross Reference List» indica dove è 
stato dichiarato un simbolo, dove il simbolo stesso 
è stato utilizzato nel codice del programma e se il 
simbolo viene letto o scritto dal programma.

Debugging
Ciascun editore dispone di un «debugger» in-
corporato, che ha le funzioni più comuni, quali 
passo-passo, breakpoint e modifica online di dati 
e istruzioni. L’editore IL possiede anche una fun-
zione «Synchronous Data View» (Visualizzazione 
Dati Sincroni), che visualizza continuamente i 
contenuti dell’ACCU, le flag di 
stato, il registro indice e i dati, 
sincronizzata con l’esecuzione 
in tempo reale del program-
ma. È inoltre disponibile un 
debugger IL stand-alone (S-
Bug).
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Una scelta  
di programma

Il pacchetto software PG5 offre tre diversi metodi di programmazione:
–	 S-Edit (programmazione in lista istruzioni)
–	 GRAFTEC (programmazione grafica sequenziale)
–	 FUPLA (programmazione con blocchi funzione)

S-Edit (lista istruzioni)
È l’editore per il potente set di istruzioni dei Saia® PCD. S-Edit, combina un editore con un «debugger» 
online, in un’unica applicazione. 
■	 La caratteristica «syntax colouring» riconosce le parole chiave valide e le colora di conseguenza. 

Ciò rende più semplice la lettura del codice di programma e gli errori di battitura vengono se-
gnalati immediatamente.

■	 Un insieme di macro definite dall’utente e potenti direttive assembler contribuiscono ad aumen-
tare la flessibilità. Ad esempio, le diverse versioni di un programma si possono assemblare in 
modo da poter essere eseguite su 
macchine diverse, partendo dallo 
stesso codice sorgente.

■	 Le funzioni dell’editore quali «Book-
marks», «Goto Line» e «Find and Re-
place» semplificano la navigazione e 
la modifica di programmi particolar-
mente estesi.

■	 La modalità «Code View» visualizza 
le istruzioni generate ed il codice 
sorgente originale. Questa carat-
teristica viene anche utilizzata dal 
debugger integrato.

GRAFTEC
GRAFTEC (programmazione grafica sequenziale) 
è particolarmente adatta per i processi sequen-
ziali. Il PCD esegue direttamente le istruzioni 
della struttura GRAFTEC ed ottimizza il tempo 
di elaborazione.
■	 I passi e le transizioni si possono programmare 

sia in lista istruzioni (IL) che graficamente con 
l’editore FUPLA.

■	 Si può utilizzare la suddivisione in sotto-pagine 
per garantire una buona visione d’insieme, an-
che delle operazioni sequenziali più lunghe.

■	 In modalità online le transizioni attive vengono 
evidenziate continuamente.
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250 «Function box» grafici  
inclusi nel pacchetto base

FUPLA
FUPLA è l’editore Saia® che permette di rappre-
sentare in forma schematica i blocchi funzionali. 
Differisce in molti aspetti dagli editori FBD:
■	 Un file FUPLA può contenere numerosi bloc-

chi di programma. Ciò significa che un file 
può racchiudere un’intera funzione della 
macchina. Per evitare duplicati ciascun bloc-
co di programma è identificato dal proprio 
nome simbolico.

■	 I blocchi FUPLA sono organizzati in pagine. 
Ciascuna pagina può produrre numerosi 
«output». Diversamente dagli editori conven-
zionali, questo permette di rendere immedia-
tamente visibili maggiori funzionalità, su una 
singola pagina.

■	 I «Function Box» grafici (FBox) possiedono 
degli ingressi e delle uscite, e possono anche 
avere proprietà configurabili utilizzando le fi-
nestre dei parametri che, a loro volta possono 
essere modificate online.

FBox standard
Nel pacchetto PG5 sono già forniti circa 250 FBox, 
di base. La gamma delle funzioni si estende ben 
oltre le normali funzioni binarie ed aritmetiche.
Per dettagli consultare le Informazioni Tecniche cod. 

26/367.

Gli FBox standard sono classificati in famiglie, sintetiz-
zabili nel modo seguente:

Comunicazioni Dati
Questa famiglia di FBox consente di leggere e 
scrivere le risorse attraverso la rete Saia® S-NET 
(Ether-S-Bus, Profi-Bus, seriali). La comunica-
zione non deve essere sempre ciclica, ma se ne-
cessario può essere controllata dal programma. 
Possono essere utilizzate anche altre funzioni, 
ad esempio, per sincronizzare tutti gli oro-datari 
su una rete.

Comunicazioni di testo
Attiva la ricezione e la trasmissione di testi attra-
verso una delle porte seriali.

Data Block
Semplificano il salvataggio dei dati sotto forma 
di data block. Viene fornito anche un FBox di 
registrazione dati.

Regolazione
Ciascun PCD ha la regolazione PID incorporata. 
L’FBox PID contiene dei parametri che possono 
essere modificati online.

Speciali
Permettono di utilizzare le funzioni speciali del 
PCD nei programmi FUPLA. Ad esempio:
–	 Leggere lo stato della batteria
–	 Trattare gli interrupt hardware
–	 Leggere e scrivere registri in Flash EPROM

FBox di tipo temporale
Comprendono gli elementi convenzionali della 
funzione tempo, più:
–	 FBox per la misurazione del tempo di ciclo
–	 Lettura e scrittura dell’oro-datario
–	 Un cronometro

Buffer
Buffer FIFO e LIFO per dati binari, interi e in 
virgola mobile.

Informazioni di sistema
Permettono di utilizzare le informazioni di siste-
ma nel programma FUPLA in modo tale che, ad 
esempio: 
–	 Il contatore di sistema possa essere letto
–	 Il numero della stazione Saia® S-Bus possa es-

sere letto e modificato
–	 Il tipo e la versione firmware del PCD pos-

sano essere letti nel programma. In questo 
modo, ad esempio, è possibile controllare se 
un programma sta operando effettivamente 
nell’applicazione pianificata



� |

Ethernet TCP/IP

EXTRANET/INTERNET

Profibus DP/FMS, LonWorks®, Saia® S-Bus, USB

PCD3.M5440

www.start-controls.com PG5 – Pacchetto software di programmazione per  Saia® PCD

Creazione di reti guidata da menu –  
con programmazione e  
diagnostica remote incorporate

Configurazione di reti
Si possono costruire a video delle 
reti di tipo Saia® S-NET, Profibus 
DP e FMS o LonWorks® mediante 
istruzioni guidate.
■	 I PCD Saia® standard e gli 

I/O remoti compaiono nella 
lista dei dispositivi e si pos-
sono inserire nella rete con 
una semplice operazione di 
trascinamento del mouse. 
Nella rete si possono im-
portare anche prodotti non-
Saia®. 

■	 Le CPU elencate nel Project 
Manager sono riconosciute 
dall’editore di rete. 

■	 I dati contrassegnati con 
un nome e scambiati tra le 
stazioni vengono visualizzati 
dell’editore dei simboli, e 
quindi possono essere utiliz-
zati facilmente in program-
mi diversi.

Teleassistenza
■	 Pianificazione dei progetti, 

programmazione e diagno-
stica con PG5 via modem 
(analogico, digitale, GSM) 
grazie alle funzioni di teleas-
sistenza, che sono parti inte-
grate nel sistema operativo.

■	 Le funzioni gateway consen-
tono un accesso continuo 
via modem alle reti locali  
(Ether-S-Bus, Profi-S-Bus, 
seriale).

■	 Le funzioni quali «callback» 
e protezione con password 
contribuiscono ad aumen-
tare la sicurezza di questi 
strumenti.
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Peculiarità utili alla programmazione

Funzionalità «on-line»
Oltre al debugger integrato in tutti gli editori, il pacchetto PG5 forni-

sce anche alcune pratiche funzionalità aggiuntive che semplificano le 

attività di messa in servizio da parte dell’utente:

«Watch Window»
Visualizza continuamente i valori degli elementi «online» selezionati, 

come ad esempio: lo stato di ingressi/uscite o il contenuto delle variabili. 

I valori dei dati possono anche essere modificati.

Funzionalità di Trasferimento Dati
Salva e ripristina i dati del programma. Lo stato di un’installazione 

può essere salvato e ripristinato in qualsiasi momento. Utile anche 

per le ricette. 

Caricamento dei soli blocchi modificati
Prima di caricare il programma, viene prodotta una lista dei blocchi mo-

dificati. L’utente può scegliere, come opzione, di caricare solo i blocchi 

che sono stati modificati dopo l’ultimo caricamento di programma

HMI Editor
È un editore per la programmazione di pagine video per i terminali. 

L’editore «Human-Machine Interface» permette di creare velocemente 

dei programmi utente per la navigazione e la visualizzazione, inclusa 

la modifica opzionale di testi e dati da terminale.

Per dettagli consultare le Informazioni Tecniche cod. P+P26/355.

OPC Server 
È disponibile un OPC server per le attività di comunicazione PG5.

Per dettagli consultare le Informazioni Tecniche cod. P+P26/357.

Librerie di funzioni per applicazioni speciali
Sono disponibili varie librerie di blocchi programma interattivi per 

tutti i moduli PCD intelligenti, oltre che per l’automazione industriale 

e degli edifici.

Per ulteriori informazioni consultare la documentazione tecnica 

riguardante i relativi moduli hardware e fare riferimento alle Informa-

zioni Tecniche: «Building Automation» e «Telecomunicazione».

Web-Editor
Creare facilmente delle pagine web Java, grazie all’editore Saia® S-Web.

I Web-Panel Saia® combinati con il Web Server integrato ed il Web-

Editor, formano un sistema a basso costo per semplici attività di vi-

sualizzazione, monitoraggio e comando. Sono disponibili diversi tipi 

di Web-Panel Saia® con display di diffrenti misure. 

FBox-Builder
L’FBox Builder di Saia® permette la creazione di FBox proprietari per la 

programmazione in Fupla. L’FBox Builder incrementa notevolmente il 

processo di sviluppo dell’FBox. E’ possibile creare degli FBox dal codice 

esistente, come FB/PB/FBox o si può iniziare un nuovo FBox da zero.

L’FBox Builder è utile anche nel processo di sviluppo di librerie di FBox, 

con funzionalità quali „Gestione della lingua», «Generatore di file di Help», 

«Pacchetto di installazione della Libreria» o «Gestione della versione».
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Dati tecinici 
Sistema operativo Windows 2000 SP4

Windows XP

PC IBM compatibile Pentium 500 o superiore; minimo 64 MB di RAM; 80 MB di spazio libero su 
hard disk; lettore di CD-ROM

Repertorio istruzioni PCD Sono supportate tutte le 150 istruzioni PCD

FBox standard Il pacchetto PG5 possiede oltre 250 FBox standard

Modem Nel pacchetto PG5 sono implementate una configurazione e una comunica-
zione modem di base. Sono disponibili anche librerie con funzioni modem 
estese, quali SMS e Pager

Linguaggi di programmazione Lista Istruzioni (IL), FUPLA (FBA) e GRAFTEC (SFC)

CPU supportate Sono supportati tutti i modelli Saia® PCD (ad esclusione della serie xx7)

Compatibilità I programmi PG3 e PG4 si possono ancora utilizzare con PG5

Communicazione In PG5 sono disponibili le communicazioni TCP/IP-, Saia® S-Bus-, Profibus 
DP-, Profibus FMS- e LonWorks®

Specifiche per la ordinazioni
Tipo Descrizione
PG5 - Demo PG5 - Versione demo con tutte le funzionalità.

Funzionamento limitato a 90 giorni
PG5 - Standard PG5 - Standard Package

Comprendente editore S-Edit per la programmazione in IL,  
HMI Editor, editori Graftec & Fupla, configuratore Profibus FMS,  
LonWorks®, configuratore di rete S-Net, librerie standard (analogiche, 
comunicazione, HMI ...) e FBox Builder (versione limitata)

PG5 - Building PG5 - Building (per building automation)
Come il pacchetto PG5 standard, con in più le librerie Heavac  
(regolatori di camera, Belimo ...)


